MEMORANDUM

To: All PTAB Users

From: James Donald Smith
Chief Administrative Patent Judge

Subject: Standard Operating Procedure 4 (Revision 5.2)

Date: September 30, 2014

The attached document supersedes the Patent Trial and Appeal
Board’s Standard Operating Procedure 4 (Revision 5.1), dated June 11,
2014.

This update to SOP4 clarifies the usage of hyphen, “en dash,” and
“em dash,” as well as the use of Board-specific abbreviations in opinions.
This version also includes additional formatting 1ssues raised since the
dissemination of the last SOP4.

Attachment:
Standard Operating Procedure 4



PATENT TRIAL AND APPEAL BOARD
STANDARD OPERATING PROCEDURE 4 (Revision 5.1)
STANDARDS FOR OPINIONS IN BOARD DECISIONS

This document sets standards for the format of opinions in decisions
by the Patent Trial and Appeal Board (Board). Standards are set with the
following objectives in mind:

(1) to ensure that opinions look professional;

(2) to place the focus on the substantive basis for opinions rather than

on selecting a format; and

(3) to maintain high quality.

Having standards in place also increases efficiency by providing guidance to
both Administrative Patent Judges (APJ) and administrative staff in opinion
preparation. The following directives are set forth to accomplish these
objectives.

This Standard Operating Procedure (SOP) creates internal norms for
the administration of the Board. It does not create any legally enforceable

rights.



L. WORKING RELATIONSHIPS AND RESPONSIBILITIES

Under the guidance of the supervisory paralegal, the paralegals on
each support team are expected to review draft documents for proper citation
form, grammar, style, punctuation, and reference to precedents and the
evidentiary record. Appendix A provides further details and some specitic
examples for the application of the standards set out below. Appendix B
provides examples for standard first page formatting of opinions.
Appendix C provides helpful hints for using tools available in Microsoft

Word to automate consistency with the standards set forth in this document.

II. STANDARDIZATION

A.  Formatting'
. Opinions are formatted in Microsoft Word; please set the
following nitial codes and settings in Microsoft Word:
a. Justification — LEFT
b. Widow-Orphan Protection — ON
¢. Font — Times New Roman 14
d. Line spacing — 1.5 (including spacing between paragraphs)
e. Margins — 1.25 inch on each side, 1.0 inch on top and
bottom (MS Word defaults), including the first page.
f. Footnotes, headers, footers, case captions, and mailing

addresses — same size font as text on page, single-spaced.

' This formatting has been selected based on multiple criteria, e.g.,
readability, reduced size (number of pages) in a resulting paper decision,
reduced size (kilobytes) in a resulting electronic file, and conventional
usage.



g. Page numbers are located at the bottom, center of each page
of the opinion, except for the first page (no page numbering
on the first page).

h. A header is placed on the front page of AIA and Interference
papers including the email, telephone number, paper
number, and date. See Appendix B.

i. On the first page of the decision, triple space before the title,
e.g., “DECISION ON APPEAL.”

J. A header shall be placed at the left side of the second and
cach subsequent page of opinions:

Appeal XXXX-XXXXXX
Application XX/XXX,XXX

or

Appeal XXXX-XXXXXX
Patent X,XXX,XXX
Reexamination Control xx/xxx,xxx

or

PR XXXX-XXXXXX
Patent x,xxx,Xxx

or

CBM XXXX-XXXXX
Patent X, XXX, XXX

or

Interference NO. XXX, XXX
[Party] v [Party]



2. General formatting for the body ot an opinion follows:

a)

b)

Use “keep with next” to keep headings on the same page
with the text underneath (click on the paragraph menu and
then the “line and page breaks™ tab).

Use “CTRL,” “SHIFT” and “SPACE” at the same time to
create a “hard space” which will keep the text on both sides
of the space together on the same line of text. This prevents
a hanging § symbol or bracket at the end of a line, etc.

Use “CTRL,” “SHIFT” and “DASH” at the same time to
create a “hard dash” which will keep the text on both sides
of the dash together on the same line of text.

Use proper ellipses: use . . .” [periods with spaces
between], not “...” Bluebook Rule 5.3.

Use an “em dash”™ to set off phrases within a sentence (see
Strunk & White Rule 8). Example: Appellant—in the
Reply Brief—acknowledges that Smith teaches hammering
anail. Form an em dash by typing the first word, typing two
hyphens, and typing the next word. Microsoft Word will
automatically convert the two hyphens into an em dash.
Alternatively, hold down the “CTRL”, “ALT”, and minus
sign (-) (found on the numeric keypad).

Use an “en dash” to connect values in a range to express a
“to” relationship. Example: 2001-2002 instead of 2001 to
2002. To insert an “en dash” use “CTRL” and minus sign

(-) (found on the numeric key pad).

g) When hyphenating compound words in a sentence use a

“figure dash” (-) which is the dash found on a conventional



keyboard. Compound words are two or more words
combined to express one concept. Examples of compound
words are: mother-in-law, tractor-trailer, light-year, better-
fitting . . . . (See also Appendix A | 33.)

h) Do not use bullet points in the body of an opinion.

i) Use two spaces after a peried at the end of a sentence or

citation.

B.  Emphasis

Italic or bold type font is acceptable for emphasis.

Capitalize and center every letter of the title and major headings,
without further emphasis, e.g., “DECISION ON APPEAL,” “ANALYSIS,”
or “CONCLUSION.” The title and/or major heading are not underlined,
italicized, or bolded.

Capitalize, underline, and center every letter of a word describing the

outcome at the end of an opinion, without further emphasis, e.g.,

“AFFIRMED.”

C.  Citation
. Legal and Technical Authority
The authoritative guide for citations is the most recent edition
of The Bluebook: A Uniform System of Citation. (See Appendix A,
item 15.)
2. Patents and Published Applications
Identify patents and published applications by at least the
surname of the first listed inventor, number, country code, and 1ssue

or publication date prior to any shorthand reference to the document,



such as “Jones.” The format and placement of initial reference
identification is left to the discretion of the authoring APJ.

In pre-AIA applications, for U.S. patents and published
applications that qualify as prior art under 35 U.S.C. § 102(¢) rather
than § 102(b), a § 102(e) filing date is not required unless the date is
relevant to an issue in the case.

3. Examples are provided in Appendix A.

D.  Grammar / Style

William Strunk, Jr. & E. B. White, Elements of Stvle (Longman 4™ ed.
1999); William Sabin, Gregg Reference Manual (Tribute ed., 11 " ed.
McGraw-Hill Co. 2011), and Lynn Quitman Troyka & Douglas Hess, Quick
Access Reference for Writers (Prentice Hall 5th ed. 2007 (or 6th ed. 2010)),
are the recommended reference guides for assistance with grammar usage
when writing opinions. For a list of other acceptable reference sources,

please consult Appendix A, item 30.

E. Separate Opinions

Separate opinions (dissents and concurrences) shall be formatted like
majority opinions as described herein. Each separate opinion shall begin on
a new page and the pages of such opinion shall be separately numbered at
the bottom center of each page of the opinion, except for the first page (no
page numbering on the first page) but succeeding pages would be numbered

(2, 3, 4, etc.).

F. Quality Oversight
1. APJs are encouraged to interact with the Paralegal in order to

successfully process decisions.



2. APIJs are encouraged to provide positive and/or negative
teedback to the Supervisory Paralegal Specialist regarding the
processing of any draft decision in an effort to ultimately reach
and/or achieve higher levels of excellence in decision processing.
3. When an issue or question arises concerning a particular
formatting item, citation, or usage of grammar, the matter shall be

resolved by following SOP4 and Appendix A.

G.  Standard First and Last Pages of an Opinion
Examples of a standard first page for opinions are set forth in the
attached Appendix B, which includes examples of pages from: an opinion in
a decision on appeal in an ex parte regular application; an opinion in a
decision on appeal in an ex parte reissue application; an opinion in a
decision on appeal in an ex parte reexamination proceeding; an opinion in a
decision on appeal in an inter partes reexamination proceeding; a decision in
an interference proceeding; a decision in an AIA proceeding; a non-public
version of a decision in an AIA proceeding; and a public version of a
decision in an AIA proceeding.
When appropriate use one of the following titles:
DECISION
DECISION ON APPEAL
DECISION ON REQUEST FOR REHEARING
ORDER REMANDING TO THE EXAMINER
ORDER REQUIRING ADDITIONAL BRIEFING BY
APPELLANT
ORDER DISMISSING APPEAL



Other appropriate titles for AIA decisions:
DECISION
FINAL WRITTEN DECISION
ERRATUM
ORDER
SCHEDULING ORDER
Examples of a first page for a decision containing a majority opinion
and another opinion (e.g., concurring or dissenting), and a standard last page
for opinions are set forth in the Appendix B.
H.  Decisions Under Seal
If a decision issued in an ALA proceeding contains information subject
to a protective order, each page of the opinion must contain text in the
header and footer (in red font) as follows:
NON-PUBLIC VERSION - PROTECTIVE ORDER MATERIAL
When the Board issues a public version of the AIA decision, each
page of the opinion must contain text in the header and footer (in green font)
as follows:

PUBLIC VERSION

III. SECTION 508 COMPLIANCE

Section 508 of the U.S. Rehabilitation Act requires that all Federal
agencies’ electronic and information technology be accessible to people with
disabilities. This requirement applies to all final Board opinions that are
posted on the eFOIA section of the USPTO’s web page and all Board
opinions made available to the public in PRPS.

Compliance with § 508 requires that text-equivalent content be

associated with all non-text elements (images or figures) within a document



to provide equivalent access. Associating text equivalent content with an
image or figure in a document must be done when the document is created.
To meet this requirement, the Board has standardized the format by
which images and figures are identified and described in the text of the
document during its creation. The format requires the following, which are
illustrated in the example below:
1. A statement identifying the image/figure must immediately
precede the image; and
2. A statement describing the image/figure must immediately follow
after the image. Example:

Figure 2 is reproduced below:

Figure 2 depicts an automobile anti-skid device.
Ensuring that Board opinions comply with § 508 is the responsibility
of the paralegal support team member. As a result, APJs must make sure

that opinions are processed through a support team member for verification

that the opinion s § 508 compliant.



Additional resources regarding § 508 compliance can be found at:

http://ptoweb.uspto.gov/wmb/s508/s508home. html
http://www.section508.gov/
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SOP4 Appendix A
Formatting

Capitalization

1. Capitalize the terms “Final Office Action,” “Amendment,” or
“Advisory Action” when referring to the title of a document of the instant
application on appeal, and capitalize the terms “Petition,” “Preliminary
Response,” “Patent Owner’s Response,” or “Petitioner’s(s’) Reply” when
referring to the title of a document in an AIA proceeding; likewise,

LI Y

capitalize the words “Examiner,” “Appellant,” “Appellants,” “Petitioner,”

and “Patent Owner” when referring to specific persons. Bluebook Rule

(hereafter “R) 8 (pp. 84-80).

Abbreviations

2. Omit periods in abbreviations of four or more words (e.g., PTAB,

BPAI, MPEP).

3. Use the symbol “§” as an abbreviation for the word “section,” and
“88” for “sections” throughout the text. However, spell out (“Section’) 1f

used at the beginning of a sentence. R3.3 (pp. 69-70); R6.2(c) (pp. 82).

4. Use the symbol “J” or “para.” as an abbreviation for the word
“paragraph,” and use “[]” or “paras.” for “paragraphs” as appropriate per
the Bluebook. However, spell out (“Paragraph”) if used at the beginning of
a sentence. R3.3 (pp. 69-70); R6.2(c) (pp. 82).

5. Spell out the word “column” within a sentence, but abbreviate as
“col.” when used in a citation. Bluebook Table (hereafter “T”") 16 (p. 473).
(Ex. 1001, col. 1, 1. 2-3 or Ex. 1001, 1:2-3).

12



SOP4 Appendix A

6. Spell out the word “line” or “lines” within a sentence, but abbreviate
as “1.” or “11.” in a citation. T16 (p. 473). (Ex. 1001, col. 1, 11. 2-3 or Ex.
1001, 1:2-3).

7. Other abbreviations used in Board decisions — the following
abbreviations represent words commonly used in Board decisions. Most of

these abbreviations are taken from the Bluebook.

I.  Court Documents (The Bluebook Bluepages Table (hereafter
“BT?’) 1)
A. The following list includes words that are commonly abbreviated

in Board decisions.

Affidavit Aff.

Answer Answer or Ans.’
Appeal Appeal (See Brief}
Appendix App.

Attormney [s] Att’y [s]

Brief Br.

If the decision contains only an Appeal Brief, then it should
be identified as Br. However, if the decision contains both
an Appeal and Reply Brief, they are identified as

Appeal Br.(or App. Br.') and Replv Br., respectively.

Declaration Decl.
Document [s] Doc., Docs.
Exhibit Ex.

'We note that this abbreviation is not specifically provided for by the
Bluebook, however, it does appear in decisions by the Board.

13



I1

I

Hearing
Reconsideration
Rehearing
Reply

Request

Transcript

SOP4 Appendix A

Hr'g
Recons.
Reh’g
Reply
Req.
Tr.

. Words of more than six letters not appearing in this table may also

be abbreviated if the abbreviation selected 1s unambiguous

(emphasis added). BT1 (pp. 28-29).

Case Names (T6)
Associate

Board
Commission
Commissioner
Committee
Company
Corporation
Department
Incorporated
Industr|y, ies, ial]
International

Laboratory

Subdivisions (T16)
Column [s]

Example [s]

14

Assoc.
Bd.
Comm’n
Comm’r
Comm.
Co.
Corp.
Dep’t
Inc.
Indus.
Int’l

Lab.

col., cols.

eX., exs.



SOP4 Appendix A

Figure [s] Fig., Figs.”
Line [s] 1., 11.
Number [s] no., nos.
Rule R.
Volume [s] vol., vols.

IV.  Abbreviations for Ex Parte Decisions

Examiner’s Answer Answer or Ans.

Appeal Briet Appeal Br., App. Br., or Br.
Reply Brief Reply Br.

Non-Final Office Action Non-Final Act. or Non-Final
Final Office Action Final Action or Final Act.
Advisory Action Adv. Act.

Specification Spec.

We note that the above abbreviations are not specifically provided

for by the Bluebook, however, they do appear in decisions by the Board.

V.  Abbreviations for AIA Decisions’

Petition Pet.

Preliminary Response Prelim. Resp.

Motion' (to amend or other) (optional abbreviated party name)
Mot.

?We note that Bluebook has *“fig.” in lower case, we have found that it looks
better when “Fig.” 1s capitalized, especially in a string citation.

* A pinpoint citation to a particular page of the paper may be included after
the abbreviation. Note, “at” should not be used to introduce the pinpoint
citation. See Pet. 4; PO Resp. 8-10; Pet. Reply 15.

15



SOP4 Appendix A

Patent Owner’s Response to PO Resp.
Petition

Petitioner’s reply to patent Pet. Reply
OWNEr response

Opposition' (to motion to (optional abbreviated party name)
amend or other) Opp.

Reply” (to opposition to motion (optional abbreviated party name)

to amend or other) Reply

Response to observation (optional abbreviated party name)
Resp.

Exhibit Ex. [number] (optional description)

Exhibit List [PO or Pet.] Ex. List

Declaration Decl. ##:##-##:## (can be used as a
short form after initial citation to
the Exhibit)

Transcript Tr. ## (can be used as a short form

after 1nitial citation to the Exhibit)

Corrected/Renewed version of  Corrected/Renewed Paper name
any paper

Miscellaneous Documents (e.g.  (optional) Paper Name in PRPS +
Mandatory Notice, Notice of (required) (Paper #xyz)

Filing Date, Related Matters,

Power of Attorney, etc. ... )

Decisions Dec. on Paper Name in PRPS (e.g.
Dec. on Mot.) with optional (Paper

‘Note — if it i3 not readily apparent to which motion this refers, i.e., several
motions have been filed, any citation may add an explanatory parenthetical
(Paper #xyz) — referencing the document # in PRPS.

16



SOP4 Appendix A

#xyz) for clarity

Orders Order Paper Name in PRPS with

optional (Paper #xyz) for clarity
Request for Rehearing Req. Reh'g

Final Written Decision Final Dec.

Other Abbreviations

The following abbreviations are also used by the Board:

Patent Trial and Appeal Board PTAB
Board of Patent Appeals and Interferences BPAI
Board of Patent Appeals (before 1985) Bd. App.
Board of Patent Interferences (before 1985) Bd. Pat. Int.

Decisions of the Commissioner of Patents Dec. Comm’r Pat.

United States Code U.S.C
Code of Federal Regulations C.FR.
Court of Customs and Patent Appeals CCPA

Federal Reporter

Federal Appendix

Federal Register

Federal Rules of Civil Procedure
Federal Rules of Evidence

Federal Supplement

Manual of Patent Examining Procedure
Official Gazette

United States Patent Quarterly

17

F., F.2d, F.3d (1st,
2d, and 3d series)
F. App’x

Fed. Reg.

Fed. R. Civ. P.
Fed. R. Evid.

F. Supp.

MPEP

Off. Gaz. [or O.G.]
USPQ



SOP4 Appendix A

Use the short cite “/d.” sparingly and only in close proximity to the specific
authority. Also, if a different pinpoint citation to a page number is included
after the “id.” use “at,” but do not use “at” when the pinpoint citation is to a
section or paragraph. For example, id. at 14, but id. § 1981. R4.1 (pp. 72-

73; Note: the period at the end of id. is always italicized).

ftalicization

8. The Bluebook provides specific guidance regarding italicization of
foreign words within a sentence (in contrast to a word in a citation). The
Bluebook provides a list of examples of words that are not italicized. R7
(p. 83). Italicize a foreign word if it 1s not in this list. Accordingly, do not
italicize the phrases “prima facie,” “en banc,” or “res judicata.”
Additionally, italicize “e.g.” and “i.e.” only when part of a signal. R7(b)

(p. 83). Note: “inter partes” 1s 1talicized.

9. Italicize signals used in citations. Some examples of signals are
shown 1in the following cites, see Ex parte Lee, 31 USPQ2d 1105 (BPAI
1993); e.g., In re Vaeck, 947 F.2d 488 (Fed. Cir. 1991). R1.2 (pp. 54-55).

Claim Formatting
10.  The formatting of claims is ultimately discretionary with the APJ.
Preferably, double-indent and single space claims with 1.5 spaces (9 pt)

between claims.

Quotations
11.  Follow the Bluebook for quotations. Quotations of 49 words or less
should be enclosed in quotation marks but not otherwise set off from the rest

of the text. Quotation marks around material quoted inside another quote

18



SOP4 Appendix A

should appear as single marks within the quotation. R5.2(b) (p. 77).
Example: “firm resolve to insure that the CIA’s ‘power that flows from

money and stealth’ could not be turmed . . . .7

Block Quotations

12.  Follow the Bluebook for block quotations. Quotations ot 50 words or
more should be in block form, and should be indented on the left and right
without quotation marks, and quotation marks should appear as they do in

the original. R5.1(a) (p. 76-77).

Citation of judicial/administrative opinions (T1).

13.  Whenever a decision is cited n full, give its entire subsequent history,
but omit denials of certiorari or denials of similar discretionary appeals,
UNLESS the decision is less than two years old or the denial is particularly
relevant. R10.7 (pp. 101-103).

14. Do not parallel cite to other sources. A parallel cite references the
same case in two or more sources. Example: Do not cite as

KSR International Co. v. Teleflex Inc. (KSR), 550 U.S. 398, 82 USPQ2d
1385 (2007); cite as KSR International Co. v. Teleflex Inc. (KSR}, 550 U.S.
398 (2007).

15.  In order of priority, use the following sources for each of the listed
decisions:
a) Supreme Court citations are to the United States Reports (U.S.), or

West’s Supreme Court Reports (S. Ct.)

19



SOP4 Appendix A

b) Court of appeals citations are to the Federal Reporter (F., F.2d or
F.3d) or the Federal Appendix (Fed. App.), when available. When not
available, citations are to the United States Patent Quarterly.

¢) District court citations are to the Federal Supplement (F. Supp. or F.
Supp. 2d) or Federal Rules Decisions (F.R.D.), when available. When
not available, citations are to the United States Patent Quarterly.

d) An opinicon not available in a printed reporter may be cited to the
Westlaw electronic database. For example, Acme Corp. v. Grimlin,
Civ. No. 2013-00598, 2007 WL 1234567, at *5 (N.D. Cal. Jan. 2,
2014). See R10.8.1 (p. 104).

¢) Board decisions are to the United States Patent Quarterly, when
available. When not available, citations are to the slip opinions
available at PTAB Reading Room. For example, Ex parte Giles,
Appeal 2011-012860 (PTAB Feb. 24, 2014); Gillman v. Stoneeagle
Servs., Inc., Case CBM2013-00047 (PTAB Feb. 18, 2014). See
R10.8.1 (p. 104). To provide a pinpoint citation to a particular page,
use the following format. Ex parte Giles, Appeal 2011-012860, slip
op. at 7 (PTAB Feb. 24, 2014); Giliman v. Stoneeagle Servs., Inc.,
Case CBM2013-00047, slip op. at 9 (PTAB Feb. 18, 2014). You also
may provide an explanatory parenthetical with the url link to the
opinion:

http://e-foia.uspto.gov/Fola/PTABReadingRoom.jsp

16.  In citations to Board decisions, abbreviate “Patent Trial and Appeal
Board” as “PTAB.” For citation to Board decisions before September 16,
2012, when the Board was known as “Board of Patent Appeals &

Interferences,” abbreviate as “BPAI’ rather than “Bd. of Pat. App. & Int.”

20



SOP4 Appendix A

For citation to Board decisions before February 8, 1985, when the Board
was known as the Board of Patent Appeals, and the Board of Patent

Interferences, abbreviate as “Bd. App.” and “Bd. Pat. Int.,” respectively.

17.  Additional guidance on citation format not addressed specifically in

the Bluebook may be found in Federal Circuit decisions.

Citation of references in Board decision
18.  The use of a table for the citation of references is at the discretion of
the APJ.
When a table is used, we recommend the following format:
The prior art relied upon by the Examiner in rejecting the
claims on appeal:

Lencoski et al. US 6,035,613 Mar. 14, 2000
(hereinafter “Lencoski”)

Waechter US 6,113,525 Sept. 5, 2000
Coley et al. US 2005/0273436 A1 Dec. 8, 2005

(hereinafter “Coley™)

O’Brien US 7,000,000 B1 Feb. 14, 2006
Carlino et al. WO 00/39666 Jul. 6, 2000

(hereinafter “Carlino™)

Metter and Colomb, WAP enabling existing HTML applications, Proc.
First Australasian User Interface Conference (AUIC) 49 (2000)
(hereinafter “Metter’”).

Michael R. Isley et al., Recent Advances in Intraoperative

Neuromonitoring of Spinal Cord Function: Pedicle Screw
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SOP4 Appendix A

Stimulation Technigues, 37 Am. JU. Electroneurodiagnostic Tech. 93
(1997).

Francis A. Carey, Organic Chemistry (Kent A. Peterson et al. eds., 6"
ed. 2006).

Migraine Definition, Meriam-Webster.com, http://www.merriam-
webster.com/medical/migraine (last visited May 1, 2014).

Changes To Implement the Inventor’s Oath or Declaration Provisions
of the Leahy-Smith America Invents Act; Final Rule,
http://www.uspto.gov/aia_implementation/fr_inventor_oath.pdf (last

visited May 1, 2014).

As can be seen in the above example, list first the U.S.
references, usually in ascending date order, followed by the foreign

references, then the journal, book and/or electronic references.

Additional patent literature examples:

Example 1:

Claims 1-16 stand rejected under U.S.C. § 102(e) as being anticipated
by Jameson (US 2003/0107596 A1, published June 12, 2003 (filed
Dec. 6, 2001))".

Example 2:
The Examiner relies upon the following prior art in rejecting the
claims on appeal:

Horvitz US 6,182,133 B1 Jan. 30, 2001

" Note that the filing date is ordinarily not required unless the date is relevant
to an issue in the case.
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SOP4 Appendix A

Yamada et al. (Yamada) US 2004/0052504 A1 Mar. 18, 2004

Sengupta et al. US 6,883,019 B1 Apr. 19, 2005
(Sengupta)

Example 3:

Chen US 6,710,101 B2 Mar. 23, 2004

(filed Jan. 15, 2003)

In the third column, list the publication or issue date, and abbreviate
the month to three (3) letters followed by a period. Exception: Do
not abbreviate the months June or July because they contain only four
letters, and September 1s abbreviated Sept. (see T12 (p. 444)).

For U.S. patents that qualify as prior art under 35 U.S.C. § 102(¢)
rather than § 102(b), list the effective filing date in parentheses in the
next line after the issue date only when such a date is a material fact in

the case.

19.  In pre-AlA applications, for U.S. patents and published applications
that qualify as prior art under 35 U.S.C. § 102(¢) rather than § 102(b), a
§ 102(e) filing date 1s not required unless the date 1s relevant to an 1ssue in

the case.

20.  For non-patent literature (NPL) documents follow Bluebook citation

form. See R15 (pp. 138-146); R16 (pp. 147-158).

21.  Citing to a patent application paragraph, do not include brackets (¢.g.,
The patent application describes elephants. Ex. 1002 | 16; Not: Ex. 1002
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SOP4 Appendix A

J [0016] or Ex. 1002 q 0016. There is no comma between the exhibit
number and the paragraph symbol. See R 3.3 (p. 69-70).

22.  Use the Exhibit number to refer to a reference in a citation sentence
(e.g., The patent describes elephants. Ex. 1001, col. 1, 1l. 2-7 or Ex. 1001,
1: 2-7).

23.  The Kind Code is the two (2) digit code that follows the publication
number of a U.S. patent or application (e.g., 9,876,564 B1). The Kind Code
range 1s from A to C3 (see explanation and examples below). If a cited
publication includes a Kind Code that is not included by the APJ in the
decision, the Paralegal should add it to the citation of the reference.
Explanation of Codes A-C:

(a) Kind Codes A1-A2 (and/or A-3 thru A9) will appear on

Patent Applications, where a PG Publication is or was issued

on or after January 2, 2001.

(b)Kind Codes B1-B2 will appear on Patents only.

{c) Kind Code B1 is used where there was NO Pre-Grant

Publication issued prior to March 2001 and the Patent

granted on or after January 2, 2001.

{(d)Kind Code B2 is used where there WAS a Pre-Grant

Publication issued prior to March 2001 and the Patent

granted on or after January 2, 2001).

(e) Kind Codes C1-C3: will appear on Reexaminations only.

(f) For additional information consult:

http://www.uspto.gov/patents/ebc/kindcodesum.jsp
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SOP4 Appendix A

Miscellaneous Opinion Formatting
24.  The format for citations to the record 1s at the discretion of the APJ,
however, the format should be consistent throughout the opinion. Examples:
“Dogs like to bark.” (Ans. 3.)
“Dogs like to bark™ (Ans. 3).
“Dogs like to bark.” Ans. 3.

25.  Line numbering for interference and reexamination decisions,

although not encouraged, 1s at the discretion of the API.

26. Headings stating an opinion is not written for publication or is not

binding precedent are not permitted.

27.  Use footnotes judiciously and sparingly. However, footnotes are at

the discretion of the APJ.

28.  Adding spaces on either side of an em dash is at the discretion of the

APJ.

29.  Referring to the parties generically as Patent Owner and Petitioner or
using their actual names is at the discretion of the panel, but the shorthand

used must be consistent throughout.
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Grammar & Style
30.  Use writing styles consistent with recognized grammar reference
sources, for example:
William Strunk, Jr. and E. B. White, Elements of Stvle (Longman 4th
ed. 1999);
Lynn Quitman Troyka and Douglas Hess, Quick Access Reference for
Writers (Prentice Hall 5th ed. 2007 (or 6th ed. 2010));
William Sabin, Gregg Reference Manual (Tribute ed., 11th ed.
McGraw-Hill Co. 2011);
Bryan A. Garner, Garner on Language and Writing (American Bar
Association, 2009);
Jane E. Aaron, The Little, Brown Compact Handbook (Pearson 2007).

Commonly encountered problems include:
31.  Avoid split infinitives (use “to go boldly” instead of “to boldly go™)
and split verb phrases (use “the response was filed timely” instead of “the
response was timely filed”)
Tip: do a global search for “ly” and look for words in between
verb phrases
Tip: common problem words include: sufficiently, clearly,
properly, specifically, reasonably, generally, explicitly,

separately, previously, originally, necessarily
32.  Use “that” and “which” properly

a) “that” is defining or restrictive: The lawn mower that is

broken is in the garage. (tells which one)
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b) “which” is nondetining or nonrestrictive: The lawn
mower, which is broken, 1s in the garage. (adds a fact about the
only lawn mower)

C) See Strunk & White (words that are commonly misused)

33. Hyphenate compound adjectives (e.g., obviousness-type double
patenting, well-known feature, long-felt need, etc.) A compound adjective
consists of two or more words that function as a unit and express a single
thought. These one-thought modifiers are derived from (and take the place
of) adjective phrases and clauses. When two or more words are combined to

form a compound adjective, a hyphen is usually required. (See Strunk &

White.)

34. Keep words of compound verbs together (e.g., use “already has been

delivered” instead of “has already been delivered”).

35.  Avoid passive voice when possible (see Strunk & White Rule 14).
36.  Be careful using the word “since,” it implies time — you normally will
want to use “because.” By the same token, the word “while,” also implies
time — you normally will want to use “although.”

37.  Unless it does not make sense in context, set off by commas phrases

like “therefore” and “thus” (e.g., “Reference X, theretfore, teaches Y

limitation™).
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38.  Use punctuation correctly — the most common problem is missing

commas {see Strunk & White — passim).

39.  Use party names consistently (e.g., “Petitioner” and “Patent Owner,”

or “Microsoft” and “Apple”).

40.  When in doubt, look to Strunk & White for guidance.

41.  Use the serial comma, 1.€., in a series of three or more terms with a
single conjunction, use a comma after each term except the last (see Strunk

& White Rule 2).

42.  Place a comma before a conjunction introducing an independent

clause.

43.  Use definite, specific, concrete language, and omit needless words

e

such as “clearly,” “meaningfully,” and “itself.”

44,  In summaries, use one tense.
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UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte [INVENTOR(S)]

Appeal [number]’
Application [number|*
Technology Center [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page of an opinion in a unanimous decision on appeal from an ex parte

regular application.

A minimum of three lines of text is required for a decision to begin on the

first page.

[No page number on front page]

' The record includes a transcript of the oral hearing held ***.
? According to Appellants, the real party in interest 1s *** (Appeal Br. *).
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UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte [INVENTOR(S)]

Appeal [number]
Application [number]
Technology Center [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.
Opinion for the Board filed by Administrative Patent Judge [NAME].

Opinion Dissenting [Concurring] filed by Administrative Patent Judge
[NAME].

[LAST NAME]|, Administrative Patent Judge.

[TITLE]

Front page of an opinion in a decision appeal from an ex parte regular

application, where the opinion contains a dissenting opinion.

A minimum of three lines of text is required for a decision to begin on the

first page.

[No page number on front page]
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UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte [INVENTOR(S)]

Appeal [number]
Application [number]
Technology Center [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME)], Administrative Patent Judge, [concurring/dissenting].

First page of a concurring or dissenting opinion.

A minimum of three lines of text is required for a decision to begin on the

first page.

[No page number on first page of concurring/dissenting 0pini0n]3

*Succeeding pages of the concurring/dissenting opinion are separately
numbered (2, 3, 4, etc.).
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UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte [INVENTOR(S)]

Appeal [number]
Application [number]
Patent [number]
Technology Center [number]

Betore INAME)], INAME)], and [NAME)|], Administrative Patent Judges.

[LAST NAME]|, Administrative Patent Judge.

[TITLE]

Front page of an opinion in a decision on appeal in an ex parte reissue

application.

A minimum of three lines of text is required for a decision to begin on the

first page.

[No page number on front page]

'S
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UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

Ex parte |PATENT OWNER|
Appellant

Appeal [number]
Reexamination Control [number]
Patent [number]
Technology Center [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page of an opinion in a decision on appeal in an ex parte

reexamination proceeding.

A minimum of three lines of text is required for a decision to begin on the

first page.

[No page number on front page]
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UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[REQUESTER]
Requester [and Appellant, Cross-Appellant, or Respondent, as appropriate]

V.

Patent of [PATENT OWNER]
Patent Owner [and Appellant, Cross-Appellant, or Respondent, as
appropriate]

Appeal [number]
Reexamination Control [number]
Patent [number]
Technology Center [number]

Betore INAME], INAME], and [NAME)],
Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

Front page of an opinion in a decision on appeal for an infer partes
reexamination proceeding.

No part of the decision is placed on the front page.

[No page number on front page]
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[OUTCOME]

[Judges’ initials]

[initials of Paralegal only]

[MAILING ADDRESS OF APPELLANT (REEXAM CASES ONLY)]

[MAILING ADDRESS OF OTHER PARTY WHEN APPROPRIATE
(REEXAM CASES ONLY)]

Last page format
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BoxInterference@uspto.gov Paper No. [number]
571.272.4683 Entered: [date]

UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[Party name],
Junior Party,
{Patents)

V.
[Party Name]

Senior Party,
(Application No.)

Patent Interference [number]
(Technology Center [number])

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page for an opinion in an interference proceeding.
A minimum of three lines of text is required for a decision to begin on the

first page.

[no page number on front page]
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Trials(@uspto.gov Paper No. [number]
571.272.77822 Filed: [date]

UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[Party name],
Petitioner,

V.

[PATENT OWNER],
Patent Owner.

Case [PR or CBM [number]
Patent [number]

Betore INAME)], INAME)], and [NAME)], Administrative Patent Judges.

[LAST NAME]|, Administrative Patent Judge.

[TITLE]

Front page for an opinion in an AIA proceeding.
A minimum of three lines of text is required for a decision to begin on the

first page.

[no page number on front page]
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Trials@uspto.gov Paper No. [number]

571.272.77822 Entered: [date]
UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[PARTY NAME],
Petitioner,

V.

[PATENT OWNER],
Patent Owner.

Case [PR or CBM [number]
Patent [number]

Betore INAME)], INAME)], and [NAME)], Administrative Patent Judges.

[LAST NAME]|, Administrative Patent Judge.

[TITLE]

Front page for an opinion in an AIA proceeding.
A minimum of three lines of text is required for a decision to begin on the
first page.

[no page number on front page]
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Trials@uspto.gov Paper No. [number]
571.272.77822 Entered: [date]

UNITED STATES PATENT AND TRADEMARK OFFICE

BEFORE THE PATENT TRIAL AND APPEAL BOARD

[PARTY NAME],
Petitioner,

V.

[PATENT OWNER],
Patent Owner.

Case [PR or CBM [number]
Patent [number]

Before [NAME], [NAME], and [NAME], Administrative Patent Judges.

[LAST NAME], Administrative Patent Judge.

[TITLE]

Front page for an opinion in an AIA proceeding.
A minimum of three lines of text is required for a decision to begin on the
first page.

[no page number on front page]
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SOP4 Appendix C

Frequently Used Microsoft Short Cut Keys

Symbol or Character

Shortcut key

Nonbreaking space
(Hard space)

Alt+Ctrl+Space

{alternative)

- Hard dash Ctrl+Shift+“dash”
Alt+Ctrl+Num-

. Em Dash (\_«vhllc holding down Alt anFl Cirl”kcys
simultaneously, hit minus sign “-” on
number pad)

- En Dash Ctrl+Num-
" | Right Single Quote | Alt+0146
’ Right Single Quote Curlt,

(while holding down Ctrl key and hit
apostrophe key 2x)

© Copyright Alt+Ctrl+C
® Registered Alt+Ctrl+R
. Trademark Alt+Crtrl+T
3 Section Alt+Ctrl+S
1 Paragraph Alt+0182

Insert Endnote Alt+Ctrl+D

Insert Footnote Alt+Ctrl+F
Highlight Alt+Crtrl+H

Print Preview Alt+Crrl+]

Format AutoFormat | Alt+Ctrl+K
Insert I_I;i{s;ldNumber Al+Crel+L
Insert Annotation | Alt+Ctrl+M

View Page Alt+Ctrl+P

42




SOP4 Appendix C

et | aocn
Edit Paste Special | Alt+Curl+V
Repeat Find Alt+Ctrl+Y
Go Back Alt+Ctrl+Z

II. Assign a shortcut key to a symbol or special character

Begin shortcut key combinations with CTRL, ALT, or a function key.

1. On the Insert menu, click Symbol.

2. Click the tab with the symbol or character you want.
Note: If you don’t see the symbol you want, in the drop-down
menus, click a different font or subset.

3. Click the symbol or character you want.

4, Click Shortcut Key.

5. In the Press new shortcut key box, press the key combination

you want to use. For example, press ALT+ the desired key.

6. Look at Currently assigned to to sce if the shortcut key

combination is already assigned to a command or other item.

Reassigning a key combination means that you can no longer
use the combination for 1ts original purpose. For example,
pressing CTRL+B changes selected text to bold. If you
reassign CTRL+B to a new command or other item, you will
not be able to bold text by pressing CTRL+B unless you restore

the shortcut key assignments to their original settings.
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In Microsoft Word the following letters A, B, G, J, Q, W, X as
well as number keys 1-9 are not assigned to any particular
character or function in conjunction with the ALT+CTRL key
combination.

7. Click Assign.

III. Replacing existing straight quotes with smart quotes
Use the following method to replace existing straight quotes with smart
quotes in a document.
1. To turn on smart quotes, follow these steps:
a. On the Tools menu [you find this under the File Tab/Help/
Option/Proofing] click AutoCorrect [AutoCorrect Options],
and then select the AutoFormat As You Type tab.
b. Under Replace as you type, click to select the "Straight

quotes' with “smart quotes” check box, and then click OK.

2. On the Edit menu [under the Home tab], click Replace.
3. In the Find what box, type a quotation mark.

4. In the Replace with box, type a quotation mark.

5. Click Replace All.

IV. Removing Line Breaks
1. On the Edit menu [under the Home tab], click Replace.
2 In the Find what box, type *p.
3. In the Replace with box, type a “space”.
4 Click Replace AllL
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In Word, a line break in the Search and Replace dialog box is
specified with the combination

"p

The “p” stands for paragraph. So searching for p and replacing with

a space will replace line breaks with spaces.
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